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The Prevalence of Ugly Academic Papers 

Please look, for just a moment, at the following random page 

from an academic draft. It’s something I’ve written, but con-

tent doesn’t matter. I don’t ask you to read the page; please 

just take in the overall impression that this page makes on you.  

 

An Ugly Academic Paper. 
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There’s nothing extraordinary about this page. A layout simi-

lar to this this dominates academic writing: the vast majority of 

unpublished papers I’ve read—that is, papers which authors 

give their colleagues, upload on portals such as academia.edu 

or SSRN, or send to conferences and journals—look like this. If 

a philosopher touches a word processor, their article is likely 

to turn out looking something like this, or something close to 

it.  Judging from anecdotal evidence, this extends to other dis-

ciplines as well. 

I find this layout a repulsive eyesore. Articles designed this 

way I find unpleasant to read, and if I don’t have to, I avoid 

reading them. The prevalence of this style is puzzling, given 

that it could be improved easily. This article tries to convince 

you that what you saw above is in fact soul-hurtingly ugly, 

and that you should stop using this layout if you do. I’ll give 

some moderate suggestions how a decently layouted academic 

paper would look like. I say “decent”, not “beautiful”, because 

I do not claim to be a layout whizz. 

Some people’s intuitive reaction will be to recommend using 

LaTeX instead. True, the default layout of a LaTeX paper is 

much preferable to the one we see in figure 1. But papers lay-

outed in Word can look just as fine. LaTeX, in fact, has a learn-

ing curve which isn’t worth it for 95% of philosophers, unless 

you tend to do hard-core formal stuff. (I’ve used LaTeX for 

many years, so I do have the comparison.) I will also give some 

practical advice on how to use Word properly. Three quarters 

of philosophers do not use Word to its full capacity, something 

which I repeatedly see in documents sent to me by others.  

Why It’s Ugly 

Before turning to details, I should describe in general terms 

why the above page is so ugly. The main virtue of a decent 

layout, I think, is that the layout itself orients the eye: it is not 

only aesthetically pleasing, but provides a visual guide to the 

structure of the text. Newspapers do this naturally: they fea-

ture clearly delineated boxes which structure the content, dif-

ferently sized headings and sub-headings, quotes set apart 

from the text, images supporting the content, and so forth. You 

will usually find that reading a newspaper is pleasing to the 

eye: paragraphs are short, you never lose track of a line, you 

find it easy to skip to what you consider the interesting parts. 

Of course, designing a newspaper isn’t the same as designing 

an academic paper, but the principles are the same. 
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The problem with the layout above is that it does very badly 

on these principles. First, the layout is unbearably monotone. 

The paragraphs are very long, and there’s no gap between the 

paragraphs. Second, it’s lacking in clear lines. The text fizzles 

out on the right-hand side without a precise boundary. The 

subsection heading has an empty line above it, but otherwise 

nothing sets it meaningfully apart, and it leaves little visual 

memory. There’s lots of white space between the lines, but it 

doesn’t really orient us to anything; it’s just space between the 

lines.  

The page also isn’t pleasing to read, for two reasons. First, the 

paragraph is very wide. Pay close attention to what your eyes 

are doing when you 

try to read, for a change, what I’m writing here. You might notice that your eyes are moving with the line.  

When you have stopped reading this line of text, your eyes 

have to momentarily reorient themselves to the beginning of 

the next line. The wider the paragraph, the harder it will be to 

reorient yourself in this way. I’m not saying that it’s impossi-

ble to do when paragraphs get wide. It just becomes more in-

convenient, more unpleasant. Good layout avoids this. (You 

might notice that newspaper columns are usually very thin.)  

Furthermore, academic writers tend to think of paragraphs 

merely as ways of compartmentalizing their thoughts; but they 

fulfil an important visual function as well. A paragraph is help-

ing us to get a natural sense of progressing in reading. If you 

zoomed out from this paragraph without trying to read its 

content, you would see that it’s roughly a box. You will find it 

much harder to identify such boxes in the layout above. That’s 

because paragraphs are so long, have no gaps between them, 

and are shot through unnecessarily with white space. 

An Alternative 

The layout I’m using in this article is not fancy at all. Still, I 

think that it is vastly superior precisely because it doesn’t fall 

for the pitfalls I described. Look just at this page. You’ll find 

that each paragraph, when looked at from afar, is roughly a 

box (that one annoying line aside), none with overbearing size. 

This helps to orient and guide the eye. There’s generous space 

between paragraphs, but each paragraph is a visual unit which 

remains coherent and clearly identifiable.  

There are other helpful visual structures. The section headings 

are set apart from the text, and if you have to find this page 

and paragraph again, you’ll find this easy. You’ll also notice 
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that the borders to the left and right of this text are very broad, 

meaning that the paragraphs themselves are thin. So your eyes 

have to do much less ‘legwork’ in scanning from line to line. I 

think you’ll find this more convenient, and perhaps even 

quicker, to read.  

You might have various reactions at this point. First, you 

might defend the standard layout on various points. I com-

monly hear that you need it for proofreading. I turn to such 

points at the end of this article. Others might think that setting 

up such layout takes extraordinary amounts of time. This is 

just plain wrong. It took me a minute to set up the layout for 

this document, and below I explain to you how. I will now de-

scribe in greater detail the elements of good layout. 

Elements of Decent Layout 

Let’s turn to some hands-on advice for improvement, then. As 

I said, this provides advice for decent layout, not brilliant lay-

out.  

SINGLE-SPACING 

Double-spacing is very hard on the eye, destroys any visual 

coherence, and in my opinion just wastes space. Single-spacing 

is all you need. Some like a bit more space between lines, in 

which case you might consider 1.2-spacing, for example. 

WIDE PAGE MARGINS 

As described above, give your reader’s eye space on the mar-

gins liberally. I would recommend around two inches (or 5cm) 

to both left and right. Around one inch (or 2.5cm) for top and 

bottom suffice. 

A PLEASANT SERIF TYPEFACE 

Your typeface should be a pleasant-looking serif typeface 

(“have little hooks”), not a sans-serif typeface like this. Unfortu-

nately, the last few years have seen a rise of papers set in Calibri, 

the typeface you see here. Sans-serif fonts are, in the opinion of 

many, hard on the eyes and should not be used for the main 

body of text. You can use them for headers if you wish; in fact, 

a carefully balanced contrast between serif headings and sans-

serif text can be very visually appealing (see below). 

AVOID TIMES NEW ROMAN 
Many people use Times New Roman—it’s the font you see in this 
sentence—and it’s often closely associated with the standard ugly 
layout I described above. With new Word versions, this is slowly 
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changing to Cambria—you see it here—which doesn’t strike me 

as a great improvement. They’re not the worst typefaces in the 

world, but Microsoft Word provides lots of alternative fonts 

you can use which look equally good or better. I’m partial to 

Palatino and Constantia, but tastes will naturally vary. 

JUSTIFIED TEXT 

Text should always be justified—that is, it should have clear 

boundaries on its right-hand side as you can see throughout 

this document. This follows the “clear visual lines” approach I 

described above. Headings need not (in fact, should not) fol-

low this, as you see here: 

MARGINS BETWEEN PARAGRAPHS, AND HEADINGS 

AND TEXT  

Paragraphs should not be “glued” to each other. There should 

be a clear visual gap between two paragraphs. I’ll later explain 

how to do this in Word. Do under no circumstances, however, 

provide space between paragraphs by pressing “Enter” twice. 

This generally misunderstands how to use Word, and also cre-

ates too much space. The same remarks apply to gaps between 

section or subsection headings and text. 

SET HEADINGS APART VISUALLY 

Your reader should be able to immediately identify visually 

(i.e., not through reading) where sections and subsections 

start. To achieve this, all headings and subheadings should be 

set apart through clear layout choices. They should have a dif-

ferent size than normal text, and have greater gaps before 

them. Think also about using indents, or bold text. Clever lay-

out doesn’t need underlining. Different hierarchical levels of 

headings should also be clearly set apart from each other.  

INDENTING SIGNIFICANT MATERIAL 

You should also consider ways to visually set apart long 

quotes, formulas, thought experiments and other significant 

material. A standard way to do so is through using block 

quotes, that is, text which has extra margins to the left and 

right: 

You are very likely to have come across this in 

good academic writing. 

USE COLOUR (MODERATELY) 

Another feature the standard layout seems to forget about en-

tirely is the existence of colour. Many of the layout aims I have 

described so far can also be achieved through using colour. 
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Dark colours are usually good choices—e.g., dark blue, dark 

red, dark green. These colours also do not diminish printabil-

ity. Usually you want to stick to only one colour though. From 

my own experience and skills, it strikes me that philosophers 

aren’t the best at choosing colour combinations. 

Another Look 

If you follow this advice, you might get a layout like this: 

 

To repeat, I don’t think this is the best layout there is, or the 

only way to have a nice layout. Still, I believe it’s clearly supe-

rior to what we started out with. Most papers I read are for-

matted in an absolutely awful way. If we move only a bit to-

wards this style, much will be gained. 
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Minor Gripes 

There are a couple of other features I tend to observe in aca-

demic papers which also should be avoided in my opinion, but 

which are more minor (and subjective). Still, let me highlight a 

few which bother me. 

First, many authors use underlining for emphasis, rather than 

italics. This might come from the dinosaur age when people 

still wrote on typewriters, where this was the main way to 

emphasise that you really meant something. There’s no reason, 

however, to use underlining when italics are available. They 

are more pleasing to the eye, fit neater into the text, and use up 

less attention than an underline does. The same remark applies 

to bold text. 

Second, indenting the beginning of a paragraph, as you 

can see here, also strikes me as unnecessary. Such indents are 

useful to highlight where a new paragraph begins if there is no 

other way to visually identify such a beginning. This is neces-

sary in the ugly layout we encountered in figure 1, but in the 

layout I have recommended, hanging indents become super-

fluous, and in fact start to look a bit silly. 

A third phenomenon which I find mostly curious is that a 

small minority of authors insist on putting several blank spac-

es between sentences, usually two.  (Derek Parfit tends to do 

it.)  You might vaguely notice this in the gap between the last 

two sentences.   Or here.   It’s subtle and often not noticeable, 

but in my opinion hurts the visual coherence of a paragraph. 

This convention might also stem from the age of typewriters. 

You can just drop it; no style guide requires or recommends it. 

Using Word Appropriately 

If you agree so far, let me get to some practical matters as to 

how to use Word. If you know what formatting styles are and 

how to use them, you can skip this section and the next entire-

ly. This section provides only a short sketch of their ad-

vantages, so you might consider googling for a proper how-to 

guide as well. I focus on Word 2007 and later. 

Most people, when they want to layout their document, high-

light a certain amount of text, and then apply whatever layout 

they wish to apply—e.g., they change font size, or spacing, or 

margins. As a general rule, on the level of paragraphs, you 

should never do this. Why? Word provides a useful and highly 

flexible way to organise your document’s layout. The idea is 
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that all formatting information for your document is saved at 

one central place. Each individual paragraph or heading then 

“inherits” its layout from this central place. The great ad-

vantage of this system is that if you change the layout saved in 

this central place, all paragraphs in your layout change auto-

matically.  

This tool Word provides through the idea of formatting styles. 

On your “Home” tab, you should see the following toolbar: 

 

(Screenshots in the following, unfortunately, will be in Ger-

man.) Each of the five squares you see—you can press the 

down arrow to see more—saves some central layout infor-

mation. “Standard”, for example, saves the format in which a 

standard paragraph in the document is layouted.  

Let’s first look at how to change styles. Right-click on the 

square, and choose “Change”. You should get the following 

dialogue: 

 

It is here that you should apply all the changes you wish to ap-

ply. If you were to change, for example, the font size to 12pt in 

this dialogue, all paragraphs throughout the document based 

on the “Standard” style will change to 12pt. See the appeal? 
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Most importantly: if you have manually reformatted individual 

paragraphs—e.g., if you have manually set them to 11pt, then 

this new central change will not apply to those paragraphs! 

This is why I insisted that you never manually format para-

graphs. 

If you click on the small “Format” button on the bottom left of 

the above dialogue, you will find a never-ending set of options 

to layout your paragraphs. If you were to click, for example, 

on the second element (“paragraphs”), you will get the follow-

ing dialogue: 

 

It is here that you can edit line spacing (“Zeilenabstand”—a 

totally useless word for your German vocabulary), for exam-

ple. I also said above that you should never hit Enter twice to 

create margins below paragraphs. Now we can see the proper 

way how to do so: we modify the “distance – after” (“Abstand 

– nach”) category. You’ll find that all your paragraphs now 

move away from each other slightly.   

I’ll leave playing around with the layout options to you. Some 

more features I will briefly highlight. First, you can create new 

layout styles at your leisure. This is unfortunately a bit hidden 

in Word. First, you will want to click on the tiny arrow, high-

lighted in orange, at the bottom right in this dialogue:  
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This should bring up this dialogue:  

 

Here, in turn, the bottom left button creates a new style (again 

orange). This should bring you to the menu you we saw on 

page 8. You can give your style a name of your choice, and 

then change it at your heart’s desire. Afterwards, it should ap-

pear in the dropdown menu of your Home tab.  

Note that formatting styles are hierarchically organised. This 

can be seen here: 

 

You can see—or guess perhaps from the German—that this 

style (“Zitat”, i.e., “Quote”) is based on the “Standard” style. 

This means that changes made to the Standard style will au-

tomatically apply to the “Quote” style, unless the “Quote” 

style explicitly makes other provisions. 

Applying a formatting style to a paragraph is easy. Move the 

editing cursor (“|”) anywhere to the paragraph to which you 

wish to apply a style. Then click on the style in the Home tab. 

If you open a new document, every paragraph should auto-

matically be already formatted in the “Standard” style. 
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Working with layout styles will take you some time to get 

used to, and you might want to set an hour or so aside to play 

around with it. But it pays off in the long run. It means that 

you can change the entire layout of your document quickly, 

painlessly, and most importantly, consistently, with just a few 

clicks.  

Automatic Headings 

One other advantage of using formatting styles I briefly wish 

to highlight are headers and subheaders. Three layouts in the 

Layout tab should be labelled “Header 1”, “Header 2” and 

“Header 3”: 

 

A first advantage is that if you use layout styles, you can use 

Word to more easily browse your own document. Go to the 

“View” tab. There you should have the following three op-

tions: 

 

If we click on the third, Word suddenly adds the following 

sidebar to your document: 

 

This shows, in hierarchical order, the contents of my paper. 

Clicking on each heading directly jumps to the relevant sec-

tion. Moreover, if I click and drag, I can move the entire sec-

tions around—e.g., if I feel that “Wide Page Margins” should 

come before “Single-spacing”, I can just drag it where I want it. 

This is a small but tremendously helpful tool, but it relies on 

using formatting styles. 
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Another thing is that formatting styles allow you automatic 

chapter numbering. Put the cursor on one of the headings for-

matted in a “Header” formatting style. Then use this symbol 

from the Home tab: 

 

This should give you the following menu: 

 

Your attention should be on those styles which have small, 

grey inset text (I highlighted them). If you were to click on one 

of them, all headers in the document would automatically be 

numbered in the suggested style—e.g., if you choose the bot-

tom left style, top-level headers would receive roman numer-

als, and so on. Googling will reveal ways to you how you can 

individualise these formats as well.  

Another nifty thing which using formatting styles allows you 

is to put chapters into your running header, like this.  
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The top of this document contains the name of the chapter 

we’re currently in (that is, the name of the current top-level 

header). To achieve this, click on the header of your document. 

Then go into the “Insert” tab, and here on “Quick Parts 

[they’re probably not called that] > Field”: 

 

This will lead to the following dialogue (it’s so hipster, you 

might have never seen it before):  

 

 What you want is the “StyleRef” field. If you were to select 

“Header 1” (here in orange), and clicked okay, then the head 

of your document would from now on contain a field which 

contained whatever the current top-level header caption was. 

Along analogous reasoning, you can select the second-level 

headers as well. This is a useful tool for longer documents, es-

pecially a thesis or book.  

A Last Bit of Advice 

Strangely enough, Word has switched off line breaking by de-

fault. (This is what you have just seen: the word “default” is 

distributed across two lines.) Without automatic line-breaking, 

text can be distributed unevenly across lines, which tends to 

look ugly. So you want to always switch it on. 
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Go on the “Page Layout” tab, and there find your way to  

“Silbentrennung”, or whatever they call it in your language. 

(Your language is unlikely to contain the beautiful word 

“Silbentrennungsoptionen”, however.) 

 

“Automatic” is doing everything you want. 

More could be said about both layout and how to use Word. 

Most people only use a tiny amount of the functionality Word 

offers. This is curious, as modifying text is one of the main ac-

tivities of an academic in the humanities. I’ve hinted here at 

the various possibilities Word offers. It’s a powerful tool and 

should be used well.  

Defending the Ugly? 

Some people will want to defend some aspects of the standard 

layout, even if they might make concessions here and there. I’ll 

consider some of these replies now, though I should say that I 

don’t have much patience for them.  

Many will defend double-spacing by saying that it’s necessary 

for proof-reading, and that this is the origin of the standard 

layout. It’s ugly, yes, but a necessity. I suspect that only a tiny 

minority of people actually use this layout for proof-reading, 

but let’s put that aside. I have two simple responses. First, 

even if you sometimes need to proof-read and this is a good 

way to do so, you shouldn’t impose that layout on other peo-

ple. It takes thirty seconds to undo double-spacing and refor-

mat for lush wide margins (if you use formatting styles!), re-

storing readability for everyone else. So format for proof-

reading if you must, but don’t impose it on everyone. 

Second, the alternative format I have suggested allows for 

proof-reading all the same. You just underline the word to be 

changed and write the necessary change on the left or right 

side. In fact, the current layout is more conducive to be used in 

such a way, as you have more space for comments to left and 

right. It’s also easier to get a sense for whole paragraphs and 

the overall flow of a text. 
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Another reply defending the standard layout is that it, well, is 

standard, and that standards fulfil important roles. One might 

say that scholars are not out to impress; they should try to 

convince with their arguments, not their layout. By having a 

simple, if admittedly dull, standard layout for articles, we can 

focus our attention on contents, not the ephemeral. The objec-

tor might add that this becomes particularly important in blind 

reviews, where flashy layout might bias reviewers. This, then, 

is a ‘levelling-down argument’ for ugliness.  

It’s true that standardising layout can sometimes be important, 

particularly in contexts of blind review. I wouldn’t advocate 

nice layout if I didn’t think it had an effect on me! But if you 

want to standardise layout, just standardise it to something 

nice. If you run a conference, don’t tell people to send in their 

papers in 12pt double-spaced Times New Roman. Tell them to 

submit papers in 11pt single-spaced Palatino with two-inch 

side margins instead. There’s no reason to make life awful for 

your blind reviewers. So there might well be a need for a 

standard, but there’s no need for the standard to be this awful. 

And there are little to no transaction costs as well: changing 

the layout of a document takes very little time. 

Another thing you might find hard to get used to are the wide 

margins to the left and right. Are these not a waste? First, in 

my experience, they’re not generally a waste of paper. I usual-

ly find that documents layouted in the style of this paper are 

not much longer or shorter than double-spaced papers. They 

will take more pages, admittedly, than single-spaced papers 

with narrow margins. But given that lots of reading happens 

on the computer nowadays, we shouldn’t obsess too much 

over how many pages our papers take. 

Another argument is that our papers should be dull, so that we 

only focus on content, not form. I think many philosophers 

revel in the idea that theirs is a deep, intellectual, difficult pro-

fession. It’s serious stuff, you know. This might be a good so-

ciological explanation of why ugly design is so prevalent in 

philosophy papers, but it’s not a justification. Of course phi-

losophy is serious business. But something can be serious 

without being ugly.  

 


